
UNITED STATES DEPARTMENT OF AGRICULTURE 
Farm Service Agency 
Washington, DC 20250 
 
For:  State Offices, County Offices, CMA’s and DMA’s 
 

CCC Assigned Warehouse Code on Warehouse Stored MAL’s 
Approved by:  Acting Deputy Administrator, Farm Programs 

 
 
1  Overview 

 
 A Background 
 

The Commodity Loan Processing System (CLPS) requires the CCC assigned warehouse 
code be entered when processing a warehouse stored MAL.  The CCC warehouse code is 
used to identify the warehouse storing the commodity under a warehouse MAL.  The 
warehouse and storage location are used to determine the loan rate.   
 
In addition, KCCO, the Warehouse License and Examination Division (WLED) performs 
warehouse examinations in support of CCC’s Uniform Storage Agreements and the United 
States Warehouse Act.  These examinations ensure the integrity of agricultural commodities 
stored in approved/licensed facilities and that the facilities meet established approval 
standards. WLED administers the contracting and compliance for storage with warehouses 
under the terms of various storage agreements such as the Uniform Grain and Rice Storage 
Agreement (UGRSA), Cotton Storage Agreement (CSA), Peanut Storage Agreement (PSA), 
and Sugar Storage Agreement (SSA).  KCCO’s warehouse examiners use the warehouse 
codes entered into CLPS to determine the quantity of grain required to be in storage when 
they conduct their warehouse audits. 

. 
Entering an incorrect CCC warehouse code when processing a MAL may be considered an 
improper payment. 

 
  B Purpose 
 

This notice reminds State and County Offices:  
 
• that a correct and valid warehouse code must be entered in CLPS when processing a 

MAL and of the: 
 
• process for identifying MAL’s in CLPS with incorrect warehouse codes 
• process for correcting MAL’s with incorrect warehouse codes 
• second party review required before MAL disbursement.    

 
 

Disposal Date 
 
 December 1, 2017 

Distribution 
 
State Offices; State Offices relay to County 
Offices, and DMA’s and CMA’s 

3-2-17         Page 1 

Notice LP-2226 



Notice LP-2226 
 
2 Valid Warehouse Codes  

 
 A Obtaining a Warehouse Code 
 
  Warehouse codes for warehouses approved and authorized to store CCC commodities, are 

assigned by KCCO.  Warehouses with an assigned warehouse code for grains and rice are 
listed on the web at:   
https://internet-dotnet.fsa.usda.gov/approved_whses/ugrsa/approved_ugrsa_whses.asp.  
The warehouses are listed by State and indicate if the warehouse: 

 
• has a UGRSA that is approved to store and handle CCC-owned grain and grain eligible 

for CCC MAL’s 
 

•  does not have a UGRSA but is authorized to store grain eligible for CCC MAL’s. 
 

  On the web site, warehouses: 
 

• with UGRSA will be displayed on the list with the following: 
 

• License Type, “Federal” or “State” 
• Warehouse Status, “Approved” 

 
• without UGRSA will be displayed on the list with the following: 

 
• License Type, “State” 
• Warehouse Status, “Authorized”. 

 
 If a specific warehouse is not listed on the web site, and has a State license issued by a State 

identified in 8-LP, subparagraph 536 B, an assigned CCC warehouse code must be obtained 
before a County Office can process and disburse a warehouse MAL.  The following 
information shall be obtained from the warehouse and provided to KCCO, WLED, SCB, 
Attention:  Paul Rodriguez through the State Office at: Paul.Rodriquez@kcc.usda.gov 

 
• warehouse name 
• location including county 
• point of contact 
• telephone number 
• State licensing number 
• capacity 
• FAX number 
• e-mail address 
• how commodity is received – truck, rail, and/or barge. 
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Notice LP-2226 
 

2 Valid Warehouse Codes (Continued) 
 
B KCCO Actions 
 

KCCO is responsible for assigning CCC warehouse codes and notifying States using a  
KC-232 of the CCC warehouse code assigned to warehouses located in their State. 

 
C Valid Warehouse Codes on Federal Warehouse Receipts 
 
 UGRSA warehouse codes for grains, oilseeds and rice commodities are 5 digits.  When 

entering the warehouse code into CLPS, employees shall enter the numbers without entering 
any leading zeros.  Also, do not enter any dashes.   

 
Example: Code on Warehouse receipt is 084858.  In CLPS, for the warehouse code, enter 

only 84858.  CLPS will automatically add a leading “0” if 5 digits are entered.  
Do not enter the leading zeros.   

 
The following is an example of a Federal Licensed Warehouse receipt.  The number circled 
in red is the CCC warehouse code.   

 

 
 
In CLPS, the user shall enter 99999 for the warehouse code.  Do not enter the dash.  The 
warehouse code entered shall match the code for the warehouse on the DACO UGRSA site 
at https://internet-
dotnet.fsa.usda.gov/approved_whses/ugrsa/approved_ugrsa_whses.asp. 
 
Notes: If the warehouse receipts display an additional digit identifying the warehouse 

branch (Example: 8-1763-2), this additional number (“2”) shall not be entered in 
CLPS. If it has been, the loan must be corrected to match the warehouse code 
number on DACO’s UGRSA approved list.  

 
CLPS allows for 6 digits because cotton warehouse codes are 6 digits.  

 
EWR’s for cotton, peanuts and rice do not appear to be a part of the incorrect 
warehouse code problem because most of the warehouse codes are automatically 
downloaded with the information entered by the warehouse.   
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Notice LP-2226 
  
2 Valid Warehouse Codes (Continued) 
 

D Valid Warehouse Codes on State Warehouse Receipts 
 
A number of States have an operating warehouse licensing program.  A warehouse with a State 
warehouse license and no UGRSA, must be assigned and receive a CCC warehouse code from 
KCCO, before allowing producers to receive a MAL for commodities stored in that warehouse.  See 
subparagraph A for additional information and 8-LP, subparagraph 536 B for a list of the States with 
an operating State warehouse licensing program.    

 
 States with a warehouse licensing program have their own State warehouse receipts or template.  The 

location of the CCC warehouse code must be included on the receipt but are not in a standard position 
nationwide.  Therefore, States must educate and inform County Office employees in their State as to 
the location of the CCC warehouse code on State licensed warehouses.   

 
Note: The warehouse name, location, county, license type, warehouse status and warehouse code 

must be included on DACO’s UGRSA web site, with the warehouse codes matching the 
numbers on the warehouse receipt 

 
3   Process for State Offices to Identify Incorrect Warehouse Codes Entered into CLPS  
 

  A State Office Action 
 

State Offices shall:  
 
• verify warehouse codes entered in their State are correct  
• identify incorrect codes and the associated MAL 
• notify applicable County Offices with codes that need corrections made. 

 
B Identifying Warehouse Codes in CLPS Using SORS 
  

The following steps may be taken to identify the current warehouse codes entered in CLPS. 
 

Step Action 
1 Access SORS at https://intranet.fsa.usda.gov/fsa/applications.asp.   
2 Under the application directory select “G-O”. 
3 Select “MAL SORS – State Office Reporting System”. 
4 Sign into SORS using eAuth. 
5 Under “State Reports” SELECT “Loan Summary”.  
6 SELECT “Condensed Warehouse Loans”. 
7 Select the applicable State and CLICK “PDF Report” and then CLICK 

“Open”. 
8 Print the “Condensed Warehouse Loans” report. 
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3   Process for State Offices to Identify Incorrect Warehouse Codes Entered into CLPS 
(Continued) 

 
  C Identifying Correct and Incorrect Warehouse Codes 
 

State Offices shall identify incorrect warehouse codes on the “Condensed Warehouse Loans” 
report in subparagraph B according to the following. 
 

Step Action 
1 Access the UGRSA warehouse listing at  

https://internet-
dotnet.fsa.usda.gov/approved_whses/ugrsa/approved_ugrsa_whses.asp.   

2 Click on the applicable state. 
3 CLICK “Edit” in the top toolbar.  Select “find on this page…”, and a data box will 

be displayed on the top left of the report. 
4 From the “Condensed Warehouse Loans” report printed according to subparagraph 

3B, enter the first warehouse code in the “Find” box.     
                 

 
 
The number of warehouse(s) with this code will be displayed.   

5 If there is a match, the code is probably correct.  Proceed to the next warehouse 
code on the “Condensed Warehouse Loans” report.   

6 If after entering the warehouse code, “no match” is displayed, this is not a valid 
warehouse code.  Mark this warehouse code for additional review.  A warehouse 
must either be an “approved” or “authorized” UGRSA warehouse to store a 
commodity for a MAL. 

 
4  Identifying Specific MAL’s with Incorrect CCC Warehouse Codes in SORS  

 
 A A SORS “Ad Hoc Query” for Monitoring Warehouse Codes 
 

State and County Offices can use SORS ad hoc queries to monitor the warehouse codes used 
for loans.  This report can be helpful for identifying erroneous warehouse codes in the user’s 
State and/or county.  This report can also identify the loan numbers with the incorrect 
warehouse codes. 
 
Follow Notice LP-2225 and the following screenshot for the various options to choose to run 
a query for a warehouse report.  Iowa is being used in this example.      
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4  Identifying Specific MAL’s with Incorrect CCC Warehouse Codes in SORS (Continued)  

 
 A A SORS “Ad Hoc Query” for Monitoring Warehouse Codes (Continued) 
 

 
 
CLICK “CSV Report” to save/open the data in Microsoft Excel.  Given the quantity of 
fields available for analysis, user can filter information more readily as CSV files in Excel 
rather than as a “Web Report” or “PDF Report.”  
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Notice LP-2226 
  
4  Identifying Specific MAL’s with Incorrect CCC Warehouse Codes in SORS (Continued) 

 
 B Filtering “Ad Hoc Queries” in Microsoft Excel 
 

Once the file is open in Excel, users can prepare the data for analysis using the following. 
 

Step Action 
1 Delete the first four rows. In SORS reports, the first three rows are blank and 

the fourth row contains a description of the report.  The first row should now 
contain the column headers. 

2 To freeze the top row, go to the “View” tab in the Microsoft Office Ribbon. 
Within the Window Panel, select “Freeze Panes/Freeze Top Row”.  This will 
enable the user to scroll through the records and still view the header row 

3 Delete or Hide all columns that are not relevant to the user query needs. Unless 
refined in the parameters, an “Ad Hoc Query” will produce a report with 39 
columns.  Most users will require a small fraction of these columns.  To delete 
or hide a column, put the cursor on the letter above the applicable column, do a 
left click on the mouse which will highlight the column.  Right click the mouse 
and left click on either “Delete” or “Hide”. 

4 To display the warehouse codes from the smallest to highest number (like the 
Condensed Warehouse Loan report in subparagraph 3 B), click on the heading 
“Whse Code.”  Go to the “Data” tab on the Microsoft Office Ribbon, and within 
the Sort and Filter Panel, click on “AZ↓.”  This will sort and display the 
warehouse code column from the smallest code to the largest code while 
viewing it in Excel.  To filter the report further, click on “Filter” within the Sort 
and Filer Panel, and use the dropdown arrow in a column header to checkboxes 
to select specific values. 

 
By filtering out the unnecessary columns, the user can create a more useful report that 
contains the County, Loan Number, Commodity, Warehouse Code, Maturity Date, 
Outstanding Quantity and Amount, Service Fee and Interest Rate. Here is an example: 
 

County 
Loan 

Number COMM 
Warehouse 

Code 
Maturity 

Date 
Outstanding 

Quantity 
Outstanding 

Amount 
Service 

Fee 
Interest 

Rate 

XXX 10001 CORN 12345 8/31/2016 7,500.00 $13,650.00 $51.00 1.625% 

 
The Warehouse Code shall then be compared for validity to the codes found at  
https://internet-dotnet.fsa.usda.gov/approved_whses/ugrsa/approved_ugrsa_whses.asp 
for the user’s State.  
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4  Identifying Specific MAL’s with Incorrect CCC Warehouse Codes in SORS (Continued) 
 
 C Saving the “Ad Hoc” Report in Microsoft Excel 
 

Step Action 
1 To save the report, SELECT “Save As”, either from the “File” tab in the 

Microsoft Office Ribbon or by pushing the keyboard button F12. 
2 Select the appropriate file location.  Since the default location will be the user’s 

download file, the user should select a different file location that is appropriate 
for the report. 

3 For the file name, remember to include a description of the report in the file 
name.  For example, if a user created a report of all outstanding CY2016 
warehouse stored MAL’s in the user’s State as of  
February 1, 2017, the file name should include such data: 
CY2016.outstanding.warehouse.MALs.2017.2.1 

4 For the “Save As” type, select Excel Workbook if you have added any 
formatting, filters or graphs.  Saving the file as a “CSV file” will remove these 
features. 

 
5 Correcting Loans with Incorrect Warehouse Codes 
 
 A Overview 
 

Once loans with incorrect warehouse codes have been identified using the ad hoc query for 
monitoring warehouse codes and the UGRSA warehouse listing website, applicable loans 
must be corrected in CLPS by canceling and re-entering the loan with the correct warehouse 
code. 

Loans where the warehouse code was incorrect that have been fully repaid, do not have to be 
corrected.   

B  Correcting Loans with No-Repayments 

The following table provides instructions for County Offices to correct loans without 
repayments. 

 
Step Action 

1 Access CLPS through “FSA Applications” on the FSA Intranet at:  
http://insidefsa.usda.gov. 

2 On the CLPS Home Screen, select applicable loan either by: 
 
• producer 
• loan number. 

3 On the Search Results Screen, CLICK “Service” next to the applicable 
loan. 

4 On the Loan Servicing Screen, CLICK “Cancel”. 
5 Using the drop-down select “Loan Correction”. 
6 CLICK “Cancel Loan”. 
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5 Correcting Loans with Incorrect Warehouse Codes (Continued) 
 

B Correcting Loans with No-Repayments (Continued) 
 

Step Action 
7 Re-enter loan using the original: 

 
• application date 
• signature date 
• approval dates. 
 
Note: Notate the original loan number on the new loan agreement and 

attach loan documents.  A new signature from the borrower is not 
required. 

8 Access NPS according to 1-FI. 
9 CLICK “Reset Payment Processing”  

 
Important: This is important to make sure the receivables created when 

the MAL was cancelled are brought in from NRRS. 
10 Certify and sign the loan package ensuring that each payment is completely 

offset by the receivable created from canceled loan 
 
Note: No further monies should be disbursed if loan has been entered 

correctly.  Producer loan proceeds as well as assessments should 
have receivables to match new loan disbursements. 

 
C Correcting Loans with Partial Repayments 

The following table provides instructions for County Offices to correct loans with 
repayments. 
 

Step Action 
1 Access NRRS through “FSA Applications” on the FSA Intranet. 
2 Activate the applicable remittance. 

 
Note: If multiple repayments have been made on loan, user must activate 

each applicable remittance. 
3 Access CLPS through “FSA Applications” on the FSA Intranet. 
4 On the CLPS Home Screen, select applicable loan either by: 

 
• producer 
• loan number. 

5 On the “Search Results” Screen, CLICK “Service” next to the applicable 
loan. 
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5 Correcting Loans with Incorrect Warehouse Codes (Continued) 
 

C Correcting Loans with Partial Repayments (Continued) 
 

Step Action 
6 Click the selected box out beside the most current repayment 

 
7 CLICK “Delete Selected Transaction” 

 
User will be prompted for reason and confirmation of deletion.  If more than 1 
repayment exists, user will need to start with the most current repayment and 
delete each individual repayment one at a time.  
 
Note: All repayments must be cancelled before the loan can be cancelled. 

8 Cancel the loan according to the steps in subparagraph B.  
 
Note: Now that the loan has no repayments associated with it, the 

instructions in subparagraph B steps 2 through 10 shall be followed. 
9 After certifying and signing payment in NPS according to subparagraph B, 

Step 10, re-access CLPS to re-enter the repayment(s).   
10 Re-enter all repayments in chronological order.  Take caution to make sure 

the following are exactly as original repayment entries: 
 
• date of repayment 
• check number 
• remitter 
• remittance amount 
• repayment amount. 

11 Access NRRS and deactivate the remittance(s). 
 
Note: The balance remaining of the remittance must be $0.00. 

 
All MAL’s with incorrect warehouse codes must be corrected in CLPS by March 23, 2017.  
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6 Second Party Reviews 
 
 A Purpose  

 
Second party reviews are required for all MAL’s before loan approval and disbursement to 
make sure that the information on which the disbursement made to the producer is correct.   

B Second Party Review for Warehouse MAL’s in CLPS 

  CLPS requires a second party review of the information in CLPS before the note and security 
agreement can be generated.  The second party reviewer cannot be the user who initially 
entered the loan application into CLPS.    

  The second party reviewer checks the information entered into CLPS for accuracy including 
but not limited to the following for a warehouse loan: 

• producer(s) name, address, and shares 
• loan application date 
• loan, storage, and funding type 
• commodity and class/variety/type 
• CCC warehouse code with the State and County 
• conditions 
• farm number(s) associated with production 
• warehouse receipt issue date 
• warehouse receipt number 
• net weight 
• net quantity 
• date commodity received 
• storage paid through date  
• in-handling charges paid or provided for 
• loan rate to make sure it is correct for the commodity and storage location 
• loan amount, service fee, assessment, if applicable, and disbursement amount  
• manual handling for additional payees 
• CCC-10 date 
• lien search date 
• name(s) of producers required to sign the CCC-678. 

 
The identity of the second party reviewer and the date the review was completed is captured 
in CLPS.   
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7 Action 
 

A State Office Action 
 
 State Office specialists shall: 

 
• ensure that their County Office employees understand where the CCC warehouse code is 

on both Federal and State, if applicable, receipts 
 

• identify the warehouse codes entered in their State in CLPS according to  
subparagraphs 3 B and C 

 
• identify MAL’s with incorrect warehouse codes according to paragraph 4 

 
• notify County Offices in their State of the loans with the incorrect CCC warehouse codes 

 
• assist County Offices with correcting the MAL’s with the incorrect warehouse codes 

according to paragraph 5 
 

• ensure their County Offices are using the second party review process to identify errors in 
MAL’s before loan disbursement 

 
• continue to monitor the warehouse codes for MAL’s in their State for possible errors.  
 

B County Office Action 
 
 County Office employees shall: 
 

• become familiar with the web sites where they can find valid CCC warehouse codes 
 

• ensure that the correct CCC warehouse code is entered when processing a warehouse 
stored MAL 

 
• correct all MAL’s with incorrect CCC warehouse codes according to paragraph 5 by 

March 23, 2017  
 

• ensure that during second party reviews the information entered in CLPS is correct. 
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7 Action (Continued) 
  

C  Points of Contact 
 
Follow this chart below for questions or concerns regarding the contents of this notice. 

 
IF the question is about… THEN State Offices shall contact… 
cotton MAL policy Kelly Hereth-Dawson by either of the following: 

 
• email to kelly.hereth@wdc.usda.gov 
• telephone at 202-720-0448. 

peanut MAL and sugar 
commodity loan policy 

George Pryor by either of the following: 
 
• email to george.pryor@wdc.usda.gov 
• telephone at 202-690-4799. 

policy for all other eligible 
commodities according to 
8-LP subparagraph 225 C 

DeAnn Allen by either of the following: 
 
• email to deann.allen@wdc.usda.gov 
• telephone at 202-720-9889. 

CMA, DMA, and LSA 
policy 

Frankie Coln at either of the following: 
 
• email to frankie.coln@wdc.usda.gov 
• telephone at 202-720-9011. 

MAL and commodity loan 
automation 

Dana Wood at either of the following: 
 
• email at dana.wood@wdc.usda.gov 
• telephone at 912-449-5303 ext. 112. 
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